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INSTRUCTION MANUAL Commercial Movie Calculator “Aquila Aedefix” 
 
November 2018 
 
Dear Licence holders and all others reading this new manual, 
We have listed all changes made in the new 2018 version here at the beginning in red to allow the 
wide community of CMC users a faster information. In blue we have enhanced the changes already 
made in 2016 and 17 
 
Beware that you can open older CMC-files with the new CMC program, but not vice versa. 
Everybody should update to the latest CMC version. 
It can be that the new CMC functions do not work or only limited with older CMC files.  
 
Settings / Project 
 

1. Quote description: 
This can additionally be edited using a few other tools (colour, bold, cut, copy, paste, etc.). 
 

2. Project: 
The name of the client now also appears below the name of the production company on the 
“Summary” page. This is entered by going to “Project” and then “Client”. 

 
     3.  Project: 

Budget date: If you want the budget to always open with the current date, enter the following 
for Budget date: =today() 

    
     4. Project: 

Project names can be changed. For example, instead of service production the photographer 
or something else can be entered. They appear on the PBS page. 

 
Settings / PDF options 
 

1.  Show markups in PBS and Print markups on detail pages 
The markups appearing on the PBS and detail pages can be separately shown or hidden. (In 
the “Gross” budget the markups do not appear on detail pages, but are included on the “PBS” 
page; where they can also be hidden.) 
 

2. Print coloured cells 
The colours selected in the budget can also be printed on the PDF. (The rows can be coloured 
as usual via “set row colour” in the “Edit” menu.) 

 
3. Add signature block to PBS 

Below the production costs on the PBS, a field appears on the PDF on which the customer and 
the contractor can write their signatures. 

 
Settings / Overtime 
 

The costs of overtime hours are listed below “Overtime”. Changing the default overtime 
results in a change within the calculation. 
The calculation of overtime has been extended. 
Overtime can now be calculated at: 100%, 125%, 150%, 200%, 250% and 300%. 

 
Settings / Internal 
 
 Text format for subtotals and grand total 
 These can be set in colour (black, blue,red) or in bold 

 
Any number of “advanced entry production costs” can be made. References to discounts, 
value added tax, extra costs, etc. can be made here. 
These and also the totals rows of the calculation can be displayed in colour and bold/normal 
on the budget’s “Summary” page on the PDF. 
Extended entries have no calculation function. 
These extra rows are also transferred to “Office” / “Summary” and to Excel file exports. 
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If the budget is being exported following the GWA scheme, we recommend that you do not 
use this addition, since the "official GWA budget" has no similar function. 

 
PBS / Remarks 
 

The “Remarks” field can be edited similar to the “quote description”. 
 

Office / Summary 
 

The right column and top row of the “Summary” page are static. “Zero values” and “Non-
calculated groups” can be hidden. 
The totals rows also appear in the post-budget of the Office summary when converting to the 
“Gross” budget. 

 
Extended and new menu functions 
 

1. View (new) 
 
a.) Select whether project windows appear with or without tabs. 
In “Project window” in the “View” menu you can select whether all projects being opened 
appear as tabs in a file or in separate windows. 
 
b.) Select “Expand or collapse all groups”. 
This determines whether the calculation folders are expanded or collapsed. 

 
2. Sub projects (new) 

 
From there, sub projects are added (new) to the opened project and can also be highlighted 
in colour, deleted and moved elsewhere. 
The space for labelng subprojects has been enlarged. 

 
3. Edit (extended) 

 
a.) The notes made via “Add comment” in the “Edit” menu are also displayed line by line  
below “Memo” on the right of the budget’s detail pages. 
An “i” symbol below the names of the comments entered refers to the comment. 

 
b.) “Set quantity / days / rate”: can be changed individually for each highlighted row or 
group or project. Shoot days will be changed with “project (only shoot days)” or “Domestic 
(only shoot days)” or “Foreign (only shoot days)” at following groups: Cast, Crew, Equipment, 
Art Department, Transportation, Distribution. 

 
4. File (extended) 

 
“Recent files” are shown. 
 

5. Print (extended) 
 
a.) “Set footer”, a text can now also be entered here. 

 
b.) Export the Summary page following the GWA standard. (new) 
New option for printing the CMC budget as a PDF of the “Summary following the GWA 
standard” page. 
Each row in the CMC is defined via "Domestic/Foreign Tools" following the GWA standard. 
Since CMC has a different structure than the GWA budget and calculations do not necessarily 
correspond to the item defined in the GWA budget due to the different requirements, they can 
be selected differently. This can be done via Domestic/Foreign Tools below GWA Export on 
the right. 
Under File an “Export GWA summary” Excel cvs file is available. This only contains all 
figures and can be used with the “KV-Vergleich” 
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6. Detail pages and Tools 
 

a.) Location and Studio (new): The OT (Overtime) function is added here. 
 

b.) Standard rates in “Domestic Tools” or “Foreign Tools” can now be entered in 
decimal numbers. They are however rounded up or down on the summary row on the 
CMC budget. 

 
 
1. Preliminary settings Mac and Windows 
Information for Mac and Windows users: 
Java, the base of this software, is inside the application folder. 
 
Mountain Lion 10.8..../Maverick 10.9....to High Sierra 
Go to „Security“ and allow a download of all programs 
 
2. Starting the program 
Double-click the clapperboard icon in the “Commercial Movie Calculator Primus” folder to start the 
program. 
After brief splash screen is displayed all typical program components such as menus, title bar, etc. will 
appear. 
Please note the licensing terms. 
The program is free for demonstration purposes. Also, service productions working on behalf of a 
licensee do not require an extra license.  
A licence can be acquired by contacting dadicmc-home.eu   
After you have agreed to my Software agreement sent to you by me you will get an e-mail including a 
license key used to register your version. Enter the license key under “File”/”Product registration…” to 
complete the registration process. 
Setting up your Logo and Footer 
You can integrate your logo by selecting it under “Print”/”Select print logo….” 
Under “Print” Set PDF footer you can install your footer (JPG, GIF, PNG) to be shown at the bottom of 
the page. 
 
3. Settings….for the calculation and the print out 
Click the “Settings” button to get to the five tabs. 
“Project, PDF options, Currencies, AGC/NIC/PN&W, Internal, Gross Estimate” 
 
3.1Project: 
The “Project” tab includes fields for entering “Product, Title, Version, Date, Job Number“ and many 
further details. 
Other changes include the naming on the PBS of the Service Film Production used. 
 
The information „Product, title, version and date“ appear on each page of the printed quote. 
These information and „ client, agency, quote version and job no.“ appear on the summary page. 
Text can be entered in "Quote Description". It will appear when printing the PBS page. All entered 
details will be shown on the page „PBS“=Production Briefing Specification. 
 
3.2. PDF options 
This is where you select the pages to print by enabling the appropriate checkboxes. 
Summary 
PBS  (Production Briefing Specification) 
Detail pages (of the quote) 
On the PDF of the details you now can see the total of all overtime and wage related costs. 
 
Carbon footprint details (your project, where you have worked out the CO2 footprint) 
Emission Facts (emission facts, basis of the Carbon Foot Print quote) 
Weather cancellation costs (details of the Weather day calculation, which you have enabled with the 
checkbox WD see weather day 
Print pre production only (pre production calculation, which you have enabled with the checkbox PP, 
see preproduction) 
“Quote Description on page 1”. This function enables you to set the page of your “Quote Description” 
(Project)  upfront the quote. 
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3.2.1. Print (menu bar) 
To print select: “Print”/ “Generate PDF” 
Printing of your quote as set at „PDF options“. 
Only those rows/description that are “populated” with numbers in the groups are printed out. All 
others are ignored. 
Markup/ handling and production fee percentages will be shown on the quote. These will be shown on 
the page „PBS“ Production Briefing Specification. 
The sum of the markups/handling and production fee will be shown on the page summary. 
To print select: “Print”/ “Generate complete PDF (domestic)” 
Printing of your quote as set at „PDF option“. 
All rows/description with and without numbers in the groups are printed out. 
Each row will show the Markup percentages as set at „Internal“. They also will be shown on the page 
„PBS“ Production Briefing Specification. 
The sum of the markup will be shown on the page summary. 
This print out does not show a separation of handling and production fee percentages or sums. 
To print select: “Print”/ “Generate complete PDF (foreign)” 
Same as before but prints the „Foreign“ quote. 
 
3.3. Currencies 
Project currency (domestic) 
This is where you can select the default currency to be used for your quote/project. 
Default currency (foreign): 
This is where you can select the default currency used for foreign costs entries. If you enter USD (for 
US dollar) for instance, then no currency code has to be entered for the costs. South Africans would 
use ZAR. 
However, when entering foreign costs you can also mix them with other currencies from the list. 
Date of exchange rates 
Fill in the date of the rate of exchange. 
Currency/Exchange Rate 
Exchange rates for the foreign currencies can be entered in the Currency/Exchange Rate column. The 
conversion rate is based on EURO 1=? or resp. the “Project currency (domestic)” 
You can also change the rate at a later stage. 
Exchange rate memo 
The sentence set default: „Exchange rate variations will be credited / debited to the client“ appears on 
the PBS can be changed. (custom) 
 
3.4. AGC/NIC/PN&W 
(Talent/Model-agency commission and National Insurance Contribution / Pension&Wellfare) 
Percentages for talent and modelling agency commission rates can be entered in the “AGC” column. 
This is separated for domestic and foreign. Additional rates can be added if required. 
Percentages for non-wage labour costs can be entered in the “NIC/PN&W” column. This is separated 
for domestic and foreign. Groups can be assigned numbers or word-based abbreviations. 
You can enter in the first rows at A instead of 0% another number. This will automatically be in use 
while quoting. Just take another one and enter 0%, so in case you need 0% you can choose it while 
doing the quote. 
 
3.5. Overtime 
Here you can enter the number for overtime. 
Enter the number of hours per day on which the overtime calculation is based if different than a 10-
hour working day. 
Then enter the number of days and hours in the fields below. 
When you are doing the quote just activate the „OT“ checkbox 
In case you want another number of overtimes, deactivate the „OT“ checkbox and work out the 
number of overtimes under „Tools“. 
 
3.6 Internal 
Internal cost type handling: Use internal / external cost type splitting 
A column will appear on the calculation page when this checkbox is enabled. You can then select 
which costs are “external” and “internal”. 
“External” is set by default. 
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These are then shown separately on the revised cost estimate and on printed out pages of actual 
costs. 
 
Split handling and production fee 
This checkbox gives you the choice between one Markup and the separation into handling and 
production fee. The „one Markup“ version is the official Standard-program. 
You can enter the percentage at following 10 positions: 
General production costs  
Cast rates  
Cast buyouts 
Director and loanout 
Non-wage labour costs 
Postproduction 
Insurance 
Service fee co-production abroad 
Travel costs 
Bad weather 
The calculation of markups or handling and production fee is done on each relevant sum. 
The total amounts of the markup or handling and production fees are shown on the pane of the 
summary. 
The percentages are shown on the PBS Production Briefing Specification and on the detail pages. 
“Separate markups for abroad (foreign) production”. You can enter different markup-percentages for 
“Domestic” and “Foreign” costs. 
The “markup” of each number entered in the quote, which basically is set under “Internal” can be 
changed per row under “Tools domestic” or “Tools foreign”. 
The meaning of the abbriviations: MU: the markup on the number entered. LNKMU: stands for 
markup on NIC/PN&W. BMU: stands for the markup on buyouts 
On the PBS the information appears: “different markups than shown above are used in some positions 
due to individual input” 
 
Payment terms and conditions: 
This is where you can select the terms of payment or enter your own. 
 
Negative insurance: 
This is where the total amount for calculating negative insurance is determined. Markup/handling and 
production fees can then be included or excluded. 
Buyouts for cast and voice artists are not included in the negative insurance total, only their fees. 
You can also specify whether the amounts for postproduction, voice artist fees and music should be 
excluded from the insurance. 
If you want to insure an amount different from what is calculated this must be entered into the form 
manually in a new row. 
 
Entry fields: Advanced entry production costs 
here you will find 2 possibilities to enter a text and an amount. 
This could be the offer of Production costs flat 
If you want to offer an overall production budget this can be entered here and will then appear as 
“Total production budget all-in excluding VAT” in the “Summary” pane. Just enter the text and the 
amount. Here you could also enter a figure including VAT, if necessary. 
 
4.PBS  (Production Briefing Specification): 
Click the “PBS” button to get to the 4 tabs with entry fields for the Production Briefing Specification 
form. (“Description, Included services, Buyouts and Time-scale”). 
Remarks 
Enter the some more general information of the project, etc. in “Remarks”. 
 
Included services 
The individual services included in the quote are marked in “Included services”. Just mark it with an 
“x” or you can add some small explanations, like “2 Castings London” under “inclusive”. 
The headings under “Service” can be changed. 
 
In “Buyouts” you can specify the validity periods, the media and countries for which you have 
calculated the buyouts for cast, voice artists, music and archive material rights. You can insert a new 
row if necessary. 
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Enter the number of days and hours planned for shooting and postproduction etc. in “Time-scale”. 
 
 
3.7. Gross Estimate 
This is an “old” function, which has been reinstalled upon request of many users. 
As many clients do not know why film productions “markup” their cost estimates; here is a way to 
avoid further discussions. 
Your cost estimate will show the gross numbers without showing any separate markup. You just enter 
the percentage of your markup and quote as usual by entering your net numbers. All numbers will be 
shown including your markup. 
 
5. Office 
4 tabs have been created in the new “Office”. 
“Summary”: Provides a summary of the currently open project, showing the calculated actual costs 
and the balance. 
In the “Office” the recon-quote differs the costs of “Inland”- and “foreign” costs. 
“Calculation” lists all of the calculations created in this file and can be enabled as an order. 
“Orders/Costs” shows all orders and the totals of costs entered (entered in advance or later on in 
revised cost estimate). 
“Invoices” shows the orders and invoices to customers can be entered along with due date and check 
mark upon receipt of payment. The outstanding total is displayed. 
 
6.Calculation procedure: 
Located below the “Office” button are the folders (“Pre-Production to Travel”) that contain the 
individual groups for the calculation. 
There are eight buttons above each group: 
Domestic/Foreign: Select the appropriate button and the group to enter domestic and/or foreign 
costs. 
Tools (domestic) / Tools (foreign): Rates can be entered in the Standard column, which are then 
used in the cost estimate. 
In “Tools (domestic)” the amounts entered are in Euro or the “project currency (domestic)” chosen. 
In “Tools (foreign)” you can choose the currency. 
Actuals (domestic) / Actuals (foreign): The calculated (Planned) costs are applied and the actual 
costs and balance displayed on the right. A general overview is available on the “Summary (internal)” 
pane. You can print the actuals by choosing „Print actuals“. 
The procedure for performing the calculation will be explained by using the “Research + Preparation” 
group in the “Pre-Production” folder. 
This is the same for the “Equipment, Art department, Studio/location, Film and digital material and 
Miscellaneous” folders/group 
You might use this command: 
Next group      ctrl and arrow down 
Previous group ctrl and arrow up 
(This enables you to “scroll” through your calculation or you might use it while entering number and 
changing from one group to another.) 
The “descriptions” for the individual items are on the left. These can be changed separately 
(overwritten) for domestic and foreign. 
These modified “descriptions” are also applied to the groups below the other tabs. 
Note: These changed descriptions are not translated into another language. 
The calculation on the domestic and foreign group is the result from: “Value x Days x Rate” 
The total for domestic appears on the right. The final currency used is always Euros or the “project 
currency (domestic)” chosen. 
You can add any number of new descriptions via the “Edit menu”. “Insert Row” or “Append Row” = 
new entry 
The formula for each group in this case “Value x Days x Rate” is also applied. 
 
Cast 
The Domestic/Foreign tabs perform the same tasks previously described. 
Then comes the editing of the columns “Value x Days x Rate”. 
Enter the number of travel days and the travel rates into the columns “T.Days” and “T.Rate”. 
You can select the percentages that you specified in “Settings”/”AGC/NIC/PN&W” in the “AGC”- and 
“NIC/PN&W” columns. 
The calculation of “AGC” is based on fees, OT (Overtime) and buyouts, but not on NIC/PN&W. 
The calculation of “NIC/PN&W” is based on fees, OT (Overtime) and buyouts, but not on AGC. 
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The next “%” column is for entering the amount of each Buyout in per cent, based on the rate you 
have entered under (shoot) “Rate”. 
If you have enabled the “Print AGC/NIC/Buyout percentages” checkbox in “Settings/PDF options” the 
percentages of AGC, NIC and Buyouts will appear in the print out of the detailed quote. 
To calculate overtime, enter the overtime in hours at each percentage (OT 100%, OT 125%, OT 
150%, OT 200%) in “Tools (domestic)” or “Tools (foreign)”. These are then recorded in overtime = 
“Overt”. 
Values and days entered in the Domestic or Foreign section will automatically be carried over into the 
„Tool“-sections. For instance: You have calculated to use 3 grips on 2 days. In Tools you can 
individually work on these numbers for overtime. 
 
This version includes a new feature allowing you to only calculate buyouts (without shooting days if 
necessary) and the AGCs and NIC/PN&Ws. 
 
Crew 
This is where “Value x (Prep days + Shooting days + Wrap days) x Rate” are calculated plus the 
number of travel days X the Travel rate. 
To calculate overtime see “Cast” 
 
Transportation 
This is also where you enter the days for Prep, Shoot and Wrap. 
 
Insurance / Domestic 
The amount set for production costs in “Internal” is automatically recorded in the “Negative” row and 
this is where you enter the percentage for “negative insurance” in the “Rate” column. 
Below this are the separate totals for equipment insurance policies: “Camera equipment, Grips 
equipment, Special equipment and Lighting equipment”. Also enter the percentage for insurance in 
the “Rate” columns. 
 
In case you wish to insure other values than shown, you must enter them “by hand” in a new row. 
 
Foreign/Insurance/Service Fee/Service Production 
Similar to the totals for insurance, the totals for all foreign costs entered are displayed here (“Service 
Fee”). 
The Service-production enters his service fee percentage in the Rate column. 
(The assigning company sets his own general handling fees and/or the production fee in “Settings” / 
“Internal”.) 
The number appearing after “Service fee” is always in the currency set as the “default currency 
(foreign)”. If numbers have also been entered in other currencies they will be converted into this 
selected currency. 
In case you wish to work on other values than automatically shown, you must enter them “by hand” 
in a new row. 
The number appearing in the Total or Foreign column is in Euros or the “project currency (domestic)” 
chosen. 
All numbers will appear in Euros or the “project currency (domestic)”” chosen in the PDF or the print 
out. 
 
Travel: 
Travel costs are divided into PPM, Travel cast, Travel Crew, Postproduction, and Presentation. 
See 8. function TR checkbox. 
 
Function of checkboxes PP,TR,WD and OT see 7. To 10. (3.5) 
7. Pre production calculation (PP) checkbox: 
A “PP” checkbox (PP = pre-production) is before every row in the Balance form. 
You then have the option of displaying specific parts of the calculation if, for example, your customer 
only wants to approve of a specific part of a calculation prior to assigning the whole project. 
Enabling the “PP” checkbox enters the numbers in the column into an extra calculation. 
The pre-production costs for the following items are calculated differently. 
For cast only the rate and NIC/AGC are calculated, but not the travel rate and the buyouts. 
For crew and transportation only the corresponding preparation days are calculated. Under 
“Settings”/”PDF options” you have the option of only printing out the pre-production calculations. 
(The selected pre-production costs always remain a part of the overall calculation). 
You can do this selection at any time. 
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8. Traveling (TR) checkbox: 
A “TR”-checkbox is before rows in the Cast, Crew, Animation, Postproduction Personnel and Voice 
artist Balance form. 
For the handling of travel costs when the checkbox is enabled, six new rows are automatically added 
to Travel Cast or Travel Crew or Travel Postproduction in the Travel folder. The Description and 
1.Flight 2.Train 3.Car 4.Taxi 5.Hotel 6.per Diems 
(you could write a name (like yours) in the description field. This would be then taken over.) 
 
9.Weatherday calculation (WD) checkbox: 
A “WD” checkbox is before (where applicable) every row. 
Checking the box enables the creation of a total for a possible day lost due to bad weather. Each 
selected “WD” checkbox adds 1 day x the rate at 100% plus the handling fees entered in “Internal” 
The amount will be shown on the PBS pane under “Weather cancellation costs per day excl. sales tax” 
and the “Summary (internal) pane” under “Weather day costs” or the pages selected for the details. 
 
10. Overtime „OT“ checkbox: look under 3.5 
 
11.“Cost estimate within a cost estimate” 
This enables you to perform as many calculations as you want in one file. 
This makes sense, since you rarely stick to one calculation for a project. 
Many different calculations are frequently made in advance and there are usually other calculations 
once the project has begun. For an extra day of shooting or an extended post, etc. 
The advantage is that calculations with special data and numbers can be reused and modified in one 
file and a calculation cannot, as was the case before, be saved to the wrong location and get lost. 
  
There is a new “Window” on the top left below the company name. Its title is “Master”. 
Right click on it, select “rename from the context menu and enter the name of the cost estimate. 
After the calculation is finished you can go to a “New subproject" and select a new calculation by 
selecting a. “Copy all values from the template” or b. “Copy only default values from the template”. 
a. means that the new cost estimate includes a 1:1 copy of all of the numbers and settings made prior 
to revision. 
b. means that only the data entered into the setting and the default values are copied for the 
calculation. 
 
12. Number verification fields: 
There are a variety of numbers always visible to you during the calculation. 
These numbers are located above the tabs: 
At the top: 
Left: The “Total costs abroad” entered (without your handling/production fees, but with service fee) 
Right: “Total production costs” (domestic and foreign total including your handling/production fees, 
without VAT) 
Displayed below this are the cost totals for the currently selected folder. 
The totals for the selected group are displayed below this. 
 
13. Edit (menu bar) The following tools are available: 
a. You want to copy a script from a word document and enter into a “Description” field. Use: 
Copy values ⌘ C 
Select panel 
and 
Paste values ⌘ V 
 
b. You want to copy the numbers of a row(s) (not the description) and enter into any other row in the 
same folder of the quote or another quote. Use: 
Copy values ⌘ C 
Select panel(s) 
and 
Paste values ⌘ V 
c. You want to copy the whole row(s) including the description, the numbers entered into the same 
folder or the folder of another quote. The whole row including the values in the tools and the values 
of the Carbon Footprint will be copied. Use: 
Copy values ⌘ C 
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Select panel(s) 
and 
Paste values ⌘ B 
Undo and Redo 
Undo ⌘ Z 
Redo Shift ⌘ Z 
 
With the following command you can highlight a row by giving colour to its contents 
⌘ R = red 
⌘ B = blue 
⌘ D = black 
 
You can add a comment to a panel of the description. 
Go to the panel 
“Add comment” ⌘ M  and write your comment and OK 
Your comment will be shown as “tooltip”, to see your comment go with the mouse there and wait a 
little… 
 
The following enables you to “scroll” through your calculation or you might use it while entering 
number and changing from one group to another. 
Next group      ctrl and arrow down 
Previous group ctrl and arrow up 
 
The following uniformly changes the number of shoot days. 
This enables you to quickly get an overview of how much f.i.another shooting day will influence costs. 
 
Change shoot days 
Fill overtime Shift ⌘ O 
(go to Tools domestic or foreign to use this tool) 
Insert Row 
Append Row 
Delete Row 
 
14. Print (menu bar) 
to print the budget look 3.2.1. print 
 
following variations are for internal use 
Print internal summary 
Print actuals 
 
15. File (menu bar) 
this file is for the use of your client in case he is using the comparison tool and can be sent via email. 
Export 4-way summary (cmcs) 
 
This file shows the contents of the page „summary“. 
Export summary as Excel (xls) 
 
this is an Excel based file showing all information of your quote 
“Export details as Excel xls” 
 
this is an Excel based file containing the actuals of the summary and the actuals of the detailed pages. 
Export actuals as Excel (xls) 
 
16. Carbon Footprint Quote 
This is a unique and simple tool to measure the carbon footprint of your project. 
You will find the „hotspots“ to measure your carbon footprint in the folders. These are marked with a 
blue CO2 sign. 
You just calculate as usual. 
You just go to CO2 (domestic) or CO2 (foreign). 
At fields, which are populated with formulas, you just choose. 
Heating: petroleum, gas, heating network, pellets, Solar heat) and enter the kWh consumption. 
Fuel: diesel or regular/premium and enter the litre consumption. 
Taxis: the entered Euro amount is automatically converted into CO2 kg. 
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Some field need your custom calculation. 
You should use the TR checkbox. This enables you to measure the CO2 print in the travelling folders. 
Travel by air: go to www.atmosfair.de, enter the destination and you will receive the value CO2 kg. 
Travel by train: go to www.bahn.de/ UmweltMobilCheck and you will receive the CO2 kg. 
Hotels: enter the number of nights. 
Heavy freights:  go to www.ecotransit.org. 
 
Setting/PDF options: you can print the details and the emission facts. 
 
Please help to improve this tool. Please mail any further suggestions to dadi@cmc-home.eu 
 
16. Four-way comparison tool 
CMS has developed a 4-way comparison tool that  
gives customers a side-by-side display allowing  
them to compare up to four summaries of production costs  
offered by producers. 
 
„Export summary cmcs“ can be found in the CMC File menu.  
This is sent to the customer via e-mail and can  
then be imported (drag and drop method) by them into the 4-way tool. 
 
For information to your clients: The 4-way comparison tool is available for free and can be 
downloaded from www.cmc-home.eu. 
 
 
In any case, if you need any help or you think you can add some great ideas, please contact me.  
 
 
Have fun calculating. 
 
Dadi van Eendenburg 
 
dadi@cmc-home.eu 
 


